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Abstract

This thesis work has been developed during an internship experience at Mi-
cromed S.p.a, an Italian company producing electromedical devices for neuro-
physiological diagnosis. To date, the company is a leader in the field of software
and hardware development of intuitive and powerful platforms capable of adapt-
ing to any workflow. Special emphasis is placed on electroencephalogram (EEG)
review and analysis software that supports easy navigation of EEG traces from
routine, long-term monitoring (LTM), intensive care unit (ICU) monitoring,
ambulatory EEG, and research studies. The main features of this software in-
clude the ability to customize user roles to fit the workflow, the presence of data
analysis and management tools and sophisticated archiving capabilities.

The main objective of this thesis project is to develop a plugin that can
allow users to access data files with Matlab, through the use of Micromed EEG
acquisition and processing software. The main need was to create a plugin to
export data recorded with Micromed devices in Matlab format.

Further goal achieved during the development of the thesis work was to make
EEG data, from Micromed files, visible and editable by using the EEGLAB in-
terface, a Matlab toolbox for processing electrophysiological signals. Moreover,
thanks to the experience in Micromed I was able to follow the project through-
out its life, investigating the operating procedure that applies to all activities
related to the analysis, design, development and qualification of new products
or to the revision/modification of existing projects/products. The goal, there-
fore, was to interface with different departments with the aim of receiving the
business needs, assess the feasibility of changes, implement the plugin, validate
and test the work and, finally, release it on the market.



Chapter 1

Electroencephalography

1.1 A theoretical overview

In the field of diagnostics, among the existing biological signals are very impor-
tant the bioelectric signals that manifest as a change in the electrical potential
between specialized tissues or organs in a living organism; they are an indicator
of the physiological state of the subject.

One particular type of bioelectrical signal is the electroencephalogram (EEG)
whose clinical uses are:

e Detecting and quantifying deficits in brain activity;
e Diagnosis of epilepsy;

e Monitoring during anesthesia;

Study of sleep phases;

e Effect of medications or drugs or meditation;

The electroencephalographic technique was invented in 1929 by Hans Berger,
who discovered that there was a difference in electrical potential between needles
inserted into the scalp or between two small metal discs (electrodes) placed in
contact with the scalp. The EEG was first used to study brain function in
animals and then on humans.

The EEG recording is obtained by appropriately applying electrodes to the
scalp. The electrodes record electrical events occurring in the underlying cortex,
around the microVolt [uV] range. The traces of potential are recorded with a
temporal resolution in milliseconds [ms] that allows, therefore, to detect events
in real time.

Electroencephalography is examined for asymmetries between the 2 hemi-
spheres (suggestive of possible structural pathology), excessive slowing (presence
of slow delta waves as occurs in depression of consciousness, encephalopathy, and
dementia), and abnormal wave patterns.



1.2 Detection system and Electrode placement

The EEG signal recording system, called electroencephalograph, is composed
by an acquisition unit for signals measured on the scalp, a signal processing
unit and a data display/storage unit. The acquisition unit adopts measurement
electrodes typically housed on a costum headset that is placed on the patient’s
head.

The surface electrodes for EEG can be attached to the skin with the help
of adhesive collars, patches or, as mentioned, a costumized headset. In order
to obtain a good recording of EEG signals, it is essential to correctly posi-
tion the electrodes on the scalp and perform a correct derivation. For this
reason, a special committee of the International Federation of Societies of Elec-
troencephalography and Clinical Neurophysiology (IFSECN) led by H. Jasper,
studied a specific system of electrode placement, to be used in all laboratories.
This system, presented at the Second International Congress in Paris in 1949
and published by Jasper in 1958, is still universally used and is known as the
International System 10-20 (ST 10-20). This type of system establishes the po-
sition of the electrodes on the scalp with a measurement system that takes into
account well-defined anatomical repere points, so that the measurements are
proportional to the size and shape of the skull; in addition, it ensures adequate
coverage of the whole head with electrodes placed in standard positions identi-
fied by a letter and a number. The letters used refer to positions on the scalp

[1]:

Occipital (0);

Parietal (P);

Central (C);
e Frontal (F);
e Temporal (T)

Numeric indexes indentify the side of the brain:

e Even numbers for right side;
e Odd numbers for left side;

e 7 letter for the middle line.

In practice, to correctly place electrodes on the scalp according to SI 10-
20, ideal lines must be drawn from particular anatomical repere points. These
fundamental lines are perpendicular to each other and are represented by:

e As shown in fig. 1, anteroAntero-posterior middle line, joining the nasion
(upper hairline of the nose) to the inion (prominence at the base of the
occipital bone), passing through the vertex; along this line we identify the 5



standard positions. Considering the total distance in centimeters between
nasion and inion, the fronto-polar point (Fp,) and the occipital point
(O,) are identified at 10% of the total distance from nasion and inion,
respectively. All other points are calculated at 20% of the interposed
distance between Fp, and O, (the designation 10-20 derives precisely
from this percentage calculation of the distance between the electrodes).
According to the ideal arrangement the middle electrode should be placed
exactly in the middle of the line between nasion and inion;

e As shown in fig. 2 latero-lateral coronal line, connecting the right and left
preauricular points via the central vertex point. On this line the temporal
electrodes should be placed at 10% of the total distance, starting from the
preauricular point, while the lateral central electrodes should be placed at
20% from the temporal points and the median central point [1];

Starting from these two fundamental lines, perpendicular to each other, it is
possible to identify the positions of the electrodes placed longitudinally to the
sides of those on the middle line and those placed on the two coronal frontal
and parietal lines, respectively to the front and back of the coronal line crossing
the vertex. The frontopolar electrodes (Fpy and Fp;) are placed along the
longitudinal line, at 10% of the distance lateral to Fp,, whereas for the occipital
electrodes (07 and Os) 10% is calculated relative to O,. The positions of the
inferior frontal (Fg and F7) and posterior temporal (T and T5) electrodes are
instead determined at 20% of this line starting, respectively, from Fp/Fp; to
01/03. The remaining frontal (Fy and F3) and parietal (P4 and Ps) electrodes
are placed along the coronal frontal and parietal lines, equidistant between the
medial and temporal lines on each side.

In a short time, the ST 10-20 has allowed to obtain a standard positioning
of the electrodes on the scalp, allowing a reliable comparison of the results
described in the various laboratories around the world; however, the above
method of application of the electrodes not being without criticism has given
way to application methods with higher resolution such as the systems 10-10
and 10-5.

With 10-10 system it is possible to identify many more localizations on the
scalp thanks to 81 electrodes placed on it; instead, the 10-5 system is represented
in the fig. 3.
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Figure 1: Representation of the antero-posterior midline connecting nasion and
inion. Distance between electrodes are reported in percentage. Following the
10-20 system, Fp is the frontopolar electrode, Fz represents the frontal, Cz the
central, Pz the posterior and O the occipital [1]
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Figure 2: Representation of the latero-lateral coronal line connecting the two
pre-auricular points passed through the vertex. Distance between electrodes are
reported in percentage. Following the 10-20 system, T4 represents left temporal
lobe, C4 the central left hemisphere, Cz the central, C3 the central right hemi-
sphere, T3 the right temporal lobe [1]



(a) Placement of electrodes according to SI 10-
10. This system involves placing 75 electrodes
on the scalp, arranged along 11 sagittal and 9
coronal chains. In this system, electrodes de-
fined in SI 10-20 as T3/T4 (right and left tem-
poral lobe) are replaced by T7/T8 and elec-
trodes T5/T6 by P7/P8 (right and left pari-
etal).

e

(b) High Density EEG: Placement of elec-
trodes according to SI 10-5.

Figure 3: Two different system: (a) 10-10 and (b) 10-5 [1]



1.3 Derivations

Among the many factors that influence how the brain bioelectric signal is dis-
played on the EEG trace, in addition to the placement of the electrodes on the
scalp, the way the electrodes are connected to the amplifiers plays a key role.

Specifically, in electroencephalography, the combination of electrodes and
how they are connected to the amplifier (mounts and leads) are essential. For
historical and practical reasons, the EEG is usually visualized as a set of traces
indicating how potential differences change in time. In a traditional trace (ana-
log EEG), each trace is the result of connecting two electrodes to amplifiers
and filters, with subsequent passage of the captured signal to the galvanometer
(an instrument used to measure small intensities of electrical currents) and the
writing pen.

With digital EEG, everything has been replaced by computer hardware and
software, but every trace continues to be marked as a channel, whether it is
produced by an analog device or processed by a computer.

The main types of derivation include:

o Referential derivations (common reference, average reference):

in common-reference recording mode, each electrode placed on the scalp
is referenced to a common electrode placed at a point x, on the scalp or
elsewhere. The common reference electrode should be as neutral as possi-
ble from the electrical point of view (not contaminated by other electrical
potentials and biological body potentials), this is rare in reality. The ma-
jor drawback of common referencing is referential contamination; when
the referential electrode is located near a potential peak there is a change
in the voltage of all the electrodes referenced to them. Equi-potential
electrodes with the reference go to zero while those less involved with the
reference show pseudo positivity. In theory, then, given a known electric
field, it would not be difficult to determine which waveform would appear
on the EEG channel depending on the reference. In practice, however, the
reasoning must be reversed, we must understand the distribution of the
potential without knowing a priori neither the site of localization of the
EEG phenomenon nor its polarity (positive or negative). Many problems
encountered in the use of the common reference can be overcome with the
average reference, also known as the mathematical reference, introduced
into electroencephalography in 1950 by Goldman and Offner [2]. In this
case the average potential of all the electrodes is considered as a refer-
ence: the potentials of the single electrodes are therefore measured with
respect to an instantaneous average value obtained by summing up all the
potentials of the applied electrodes.The average reference potential will
therefore be closer to zero the greater the number of electrodes. One of
the properties of the mathematical mean of a series of numerical values is



that the sum of the differences of the mean is zero. This means that on the
EEG trace we will always have positive or negative deflections, compared
to the zero value of the reference.

e Bipolar derivations :

in this case the potential difference is calculated between pairs of elec-
trodes, placed along chains (longitudinal or transversal) in which an elec-
trode is in common between two successive channels. In this way an event
located under a certain electrode will produce an equal but opposite de-
flection in the two adjacent electrodes which precede and follow it in the
electrode chain.

Because EEG patterns are highly variable (focal or diffuse, transient or per-
sistent), there is no single ideal derivation to highlight all types of activity. A
first important factor to consider when choosing leads is inter-electrode distance,
and this is especially true for common active and bipolar leads.

In the case of bipolar leads the distances between the paired electrodes are
small and equal and this highlights the fastest EEG activities; in the case of the
common active reference, the distances are instead larger and unequal and this
allows an amplification of the signal, highlighting better the slow activity.

The figure (fig. 4) shows how the visualization of a real epileptic focus
changes, recording with digital equipment, depending on the lead visualized
in bipolar lead, medium referential (AVG), active common referential (G2).
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Figure 4: Imaging of a real epileptic focus (spikes in the left middle temporal
site), recorded with digital equipment, depending on the derivation visualized
in bipolar and referential derivation. Spikes corresponding to seizures in the
respective derivation are highlighted in red [1]



1.4 Electrode Mountings

Mounting refers to the specific way the electrodes are connected to the EEG
recording channel. In EEG laboratories, there is a wide variety of montages used
for routine recordings; this multitude prevents the proper exchange of informa-
tion between specialists in the field and can be a disadvantage to the patient. To
resolve this issue, both the International Federation of Clinical Neurophysiology
and the American Clinical Neurophysiology Societies have published guidelines
for fitting. The different assemblies are referred to as longitudinal bipolar (LB),
transverse bipolar (TB), or referential (R).

Each montage is defined for 16, 18, and 20 channels.

In brief, the main recommendations describing the guidelines are:

e Record while simultaneously viewing at least 16 EEG channels;
e Place at least 21 electrodes according to SI 10-20;
e Use bipolar and referential assemblies;

e Indicate at the beginning of each assembly the electrode connections for
each channel with a simple and easily understood connection mode;

e In bipolar leads, electrode connections should follow continuous lines with
equal interelectrode distances;

e Electrode progression should be antero-posterior;

The figure (fig. 5) shows the bipolar mounts used routinely, depending on

the number of electrodes applied to the scalp, which is also dependent on the
size of the patient’s head.
Regarding the common reference mounting, the international guidelines recom-
mend as reference the right auricle (A2) for right electrodes and the left auricle
(A1) for left electrodes. Currently, in digital electroencephalography, G2 can
also be used as active reference, placed on the midline anterior to Fz [1].

10
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Figure 5: Bipolar, longitudinal, and transverse mounting groups routinely used,
depending on the number of electrodes applied to the scalp, also dependent on
its size. The right auricular (A2) for right electrodes and the left auricular (A1)

for left electrodes are recommended as reference [1]
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1.5 Main waves

During the analysis of EEG signals it is possible to identify several areas, with
distinct amplitudes and characteristics; each of these areas is characterize by a
wave signal:

Alpha («) rhythm, is the basic rhythm present in EEG, also called ”Berger
rhythm”; it is possible to distinguish the slow « (8-9 Hz), the intermediate
a (9-11.5 Hz) and rapid « (11.5-13 Hz), with an average amplitude of 30
uV.

This rhythm is recorded with closed eyes in an awake subject, especially
between the occipital and parietal electrodes, compared with the posterior
central and temporal electrodes. Alpha waves (8-13 Hz) are characterized
by waking conditions but at mental rest but are not present in sleep;

Beta (8) rhythm, is distinguished into slow S (13.5-18 Hz) and fast j
(18.5-30 Hz) and has an average electrical voltage of 19 puV (8-30 pV).

Beta waves are dominant in a subject with eyes open and engaged in any
brain activity, almost continuous in alert states but also during dream
sleep (during dreaming);

Theta (6) rhythm is dominant in the newborn but also present in many
adult brain disorders, in states of emotional tension and in hypnosis. It is
distinguished in slow 6 (4-6 Hz) and rapid 0 (6-7.5 Hz), with an average
voltage of 75 pV'.

In normal conditions the theta phase occurs in the first minutes of falling
asleep, when a subject is still in a state of drowsiness, where it is then
alternated by graphemes called sleep spindles.

Sigma (o) rhythm, which appears during sleep. It appears at a frequency
of 12-14 Hz and electrical voltage of 5-50 uV.

The sigma rhythm shows up as trains of waves together with other graph-
ical elements called K complexes.

Delta (§)rhythm, which appears about 20 minutes after sleep start (esti-
mated time to reach deep sleep stage). It is characterized by a frequency
between 0.5 and 4 Hz and an average electrical voltage of 150 uV'.

Delta waves are not present under physiological conditions in the wak-
ing state in adulthood; they are predominant in childhood, occur during
general anesthesia of a subject, in some brain diseases or in general dys-
metabolic diseases, such as hyperazotemia.

12
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Figure 6: Characteristic EEG waves. In red, Alpha («) rhythm, is the basic
rhythm present in EEG; in green, Beta (8) rhythm, is dominant in a subject with
eyes open and engaged in any brain activity, almost continuous in alert states
but also during dream sleep (during dreaming); in orange, Delta (§)rhythm,is
predominant in childhood; in violet, Theta (#) rhythm is occurs in the first
minutes of falling sleep; in blue,gamma () rhythm is hardly visible in an EEG
recording given the limited amplitude [1]
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Figure 7: Spatial localization of EEG rhythms: the parts of the scalp from
which the main characteristic EEG waves originate are highlighted [1]



1.6 Clinical Applications

The EEG is a non-invasive procedure, and for this reason it is suitable for
subjects of any age and allows the doctor to observe brain activities: it is used
for research purposes in neuroscience (for example for the study of disorders
of the sleep or memory) and for medical evaluation and diagnosis of certain
diseases such as epilepsy or primary brain tumors and any metastases that lead
to epileptic episodes.

The EEG allows not only the recording of anomalous activities, but also
their location. The EEG allows to study the brain condition in different states
of the patient:

e During wakefulness and during sleep;
e During a particular activity or during the inactivity of the subject.

The EEG then makes it possible to identify the activations caused by abnormal
changes in electrical activity, such as epilepsies.

It has diagnostic validity as it allows the diagnosis of numerous diseases, but
it can also be used for the diagnosis of exclusion (i.e. to exclude a pathology or
cerebral anomalies, rather than to confirm their presence).

The conditions that benefit most from the exam include:

e Tumor or even circulatory brain lesions;

e Degenerative diseases (Alzheimer);

e States of reduced consciousness (such as, vegetative states, brain death);
e Metabolic alterations;

e Response to certain medications or drug use;

e Head trauma,;

e Psychiatric diseases;

e Encephalopathies;

e Stroke;

e Cerebrovascular disorders.

Depending on the type of examination performed, the duration of the EEG
can vary from minutes (basic EEG) to hours (dynamic EEG). In any case, it is
a non-invasive examination and on average well tolerated by patients.

15



Chapter 2

Case Study: Brain Quick
Software®

This chapter includes an overview of Brain Quick (BQ) Software which is the
software that manages all Micromed acquisition and review systems for EEG,
Video EEG, Long Term Epilepsy Monitoring (LTM), Stereo EEG, Ambulatory
EEG/PSG, EEG recording during functional MRI, evoked potentials.

2.1 Main Software Features

BQ Software is designed to help physicians in recording, reviewing and ana-
lyze data coming from Micromed digital acquisition systems and it can be used
in EEG, LTM, PSG and EP exams for neurophysiologic studies. The software
could also be used for cortical stimulation during electroencephalography exam-
inations (i.e. stereo EEG) in combination with specific Micromed stimulators.
In addition, BQ Software can monitor physiological measurements such as In-
tracranial Pressure (ICP), the Oxygen of the Brain Tissue (PbtOs), Cerebral
Perfusion, Heart Rate (HR) and the Oxygen Saturation in the Blood (SpO2)
coming from third- party interfaced medical devices.

Some functional analysis tools are provided as predefined options or software,
but results from these tools should never replace critical interpretation and
clinical conclusions that pertain only to the physician. With reference to this,
the use of BQ software is reserved for physicians, technicians, or other health
care professionals who are educated in the recording of biopotentials. This is
because the software is not designed to continuously monitor the functionality of
the Central Nervous System autonomously, as it is not equipped with adequate
alarms that replace medical surveillance.

Therefore, the use of BQ Software should always be done under the super-
vision of a physician or a qualified technician.

16



BQ software is available in a variety of languages so that it can be used
internationally. Thus, the software is able to display information in all languages
using a multitude of characters. The language can be set by the archive data
manager. It is also able to handle non-character languages such as Chinese,
Russian, Hebrew and so on.

The BQ software is designed to be multifunctional giving the possibility to
manage archived and non-archived historical studies, make remote reviews of
ongoing studies performed by SystemPlus Evolution (Acquisition system that
generates Micromed EEG files - TRC files), create reports and manage tem-
plates, make multiview examinations, start a new recording of the EEG exam-
ination according to predefined or selected protocols or start a new recording
with the last protocol used, create a new history, a new report and manage
report templates.

BQ manages the configuration of the various settings on three levels:

e User : the setting is unique for a specific user on a specific machine; at
this level the defined settings are preferences such as branch labels, cursor
time, background etc... or screen capture preferences.

e Unit : the setting is unique for all users on a specific machine; at this level
the defined settings are electrode position configuration, event definition,
average (AVGQ) reference configuration, calibration monitoring.

e Central : the settings are applied to all machines and for all users of the
system; at this level the defined settings are Internationalization, Lan-
guage, Notch.

17



2.2 Software User Interface

The interface of BQ Software presents, first of all, the title bar from which it
is possible to view the type of open window (EEG trace or Report) and the
information regarding the patient. A ribbon bar (fig. 8) contains the toolbar
which allows access to all the functions and their visualization in different modes.
In this way, the user can customize all the tabs by defining the functions that
must be present.

This software, moreover, makes it possible during acquisition and review,
the tagging of general events such as notes, digital triggers, annotations, flags
and selections thus allowing a customization of the path. In the same way it is
possible to tag events such as High Frequency Oscillations (HFO).

Through the interface it is possible to view the properties of the EEG
trace such as start/end and duration of the recording, number of raw chan-
nels recorded, sampling rate, resolution and acquisition device. To complete
the software, the ”video” option allows the user to define the characteristics of
the recorded video; furthermore, the user can also access the acquisition proto-
col.

Among the many features listed so far, BQ has in correspondence of the main
button, the ”"Export” function which has been updated during my internship
experience at Micromed, as we will in chapter 4. BQ Software has been designed
with an option that allows the user to perform different types of exports (fig. 9)
such as :

e Export in Ascii (American Standard Code for Information Interchange)

e Export in edf (European Data Format - simple and flexible format for
exchange and storage of multichannel biological and physical signals)

e Export Event
e Export Analyzer Data

The export function is available from the menu that opens by clicking on
the BQ Application button. In chapter 4, we will see how this menu has been
updated with an export function in .mat files, that is the proprietary file format
that can be managed in the Matlab programming environment.

18
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Figure 8: Example of BQ Software Ribbon Bar; main features are shown such
as montage parameters, events, filter parameters, analyzers
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Figure 9: BQ Software Export Features: existing export features in the EEG
acquisition software are shown

19



2.3 Events

As anticipated, BQ Software allows to customize the EEG trace. In this para-
graph the different types of customization are discussed in detail (fig. 10).

Regarding the Notes, the software allows the user to insert notes to distin-
guish particular events during the review and acquisition. Notes are displayed
as vertical blue lines and direct insertion of comments can take place.

As for Digital Triggers, the software allows the user to mark the track using
events of this type during acquisition and review. Digital Triggers are composed
of a numerical value stored inside the track and an analog trigger; the numerical
value informs about the type of event that generated the trigger. This type of
event is displayed with green vertical lines in the EEG page and in the time bar.

In addition, BQ Software allows the user to mark a piece of track with
HFO events during the review and acquisition phase. BQ enables automatic
HFO detection by automatically marking the parts of the trace where they are
present. The various waves in the EEG tracing corresponding to particular
groups of applied electrodes can be seen in different colors from each other.

Moreover, BQ allows the user to define custom events in order to create a
new type of event by choosing its graphical and input properties. The following
information can be displayed for each event: type (each event corresponds to
a label), time position in the trace (time the event was added to the trace),
duration (the event has a start date and an end date).

s -l ol @«

— [~ ) N o CIoREYC)

Figure 10: Example of customization of an EEG trace: during review the user
can add different types of events (colorful flags on the ribbon bar) with vertical
lines. It is shown how the user can select parts of the trace to indicate particular
events such as hyperventilation, seizures, sleep, artifacts but also to select parts
of the trace that are clinically interesting
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Chapter 3

Product Development
Protocol (PDP)

In order to implement a change to the main software and thus add the new
export functionality, a new software version needs to be released. To do this,
documentation must be produced that is useful for the company to be able to
supervise the activities carried out; with this purpose, company protocol was
followed to correctly perform the thesis work.

3.1 General Informations

Product Development Protocol (PDP) refers to an operating procedure that
applies to all company activities related to the analysis, design, development
and qualification of new products or the revision of existing designs/products.

The purpose is to provide guidance and determine responsibilities for the de-
sign and implementation of all new, custom and experimental devices, including
prototypes and product variants. In the PDP, it must be considered that there
are different types of projects; in the specific case of this thesis work, a so-called
minor project (MPR) was developed that requires the existence of a device that
meets the regulatory requirements applicable to the intended markets. Specif-
ically, the minor modification made to the existing EEG acquisition software
consists of the addition of a new feature that does not require a new regulatory
submission or substantial verification and validation.

Regarding the design documentation for software projects, we refer to the
Software Requirement Specification (SRS) which must include the implementa-
tion of a specific Functional Requirement Document (FRD), an overview of the
hardware device features that are controlled by the software and a description
of the expected operating environment. The SRS describes the implementation
of the requirements for the software device.
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In terms of the relationship between the FDR and SRS, the FDR describes
what the product must do (user requirements) and the SRS describes how the
requirements in the FRD will be translated into software constraint capabilities
(design inputs) [3]. Below we will detail the steps approached to design the
plugin that is the subject of this thesis.

3.2 Stage 1: New Idea and Feasibility

The purpose of this phase is to identify potential ideas for new products or
reasons for redesigns, determine the scope or variant of the project, present
them to the project management team, and evaluate the costs and resources
involved.

In practice, following meetings with the R&D department team, it was de-
cided to implement a program that would allow the export of data corresponding
to EEG tracings acquired with Micromed devices.

The project should have adapted to the needs of the end user and therefore
aimed to export key values such as sampling rate, various acquisition conditions,
number and type of events placed on the trace during and after acquisition (in
review). Next, we also wanted to expand the visibility of the exported values
through the EEGlab tool (please refer to chapter 4 section 4.2); this required
further planning of both the work and the resources to be employed.

3.3 Stage 2: Design

In this stage it is expected to complete the majority of the design work, define
user requirements, and gather associated information to identify and refine ap-
plicable design parameters and create design specifications. This phase basically
involves answering the questions:

e What should the device do?

e Who is it intended for?

e What are the known constraints for development?
e What does it look like?

e How is it used?

In order to answer most of these questions formally, I needed to draft the
FRD document; as introduced in the previous paragraphs, this document de-
scribes the software requirements for the new export plugin in Matlab to be
added to Brain Quick. It is organized into two sections: the first contains the
user requirements and the second contains the functional requirements that sat-
isfy those requirements. The following is a schematic outline of the contents of
that document(fig. 11)(fig. 12).
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User Needs

e ul Description

number

MP-UN1 Export of EEG traces in Matlab
User needs to open EEG files recorded by Micromed systems in Matlab.

MP-UN2 Electrode
The user needs to be able to see which electrodes are recorded, the order and
number of electrodes used.

MP-UNZ Events
The user needs to display in Matlab different types of events marked in the EEG
trace during recording or in review with Brain Quick and saved in EVT file

MP-UN4 Notes
The user needs to see in Matlab the notes added in the EEG trace during recording
or in review and saved in the TRC file.

MP-UMNS Flags
The user needs to see in Matlab the portions of data highlighted with red, green and
blue FLAGs in the EEG trace during recording or in review and saved in the TRC
file because they are areas of interest or for further processing.

MP-UNG Trigger

The user must see in Matlab the digital triggers added in the EEG trace during
recording or in review and saved in the TRC file.

Figure 11: Functional Requirements Document: User Needs
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Functional Requirements

Requirement
number

Description

MP-FR1

The software shall convert TRC files to .mat files (MATLAB)
containing the corresponding information. The software shall
also manage EVT files.

The operation can be done directly through Brain Quick with
the addition of a new feature: "Export .mat".

MP-FR2

The software shall identify the stored electrodes, their order
and number. It shall be possible to view the electrodes
registered and associated with the correct channel.

MP-FR3

The software shall allow to visualize in the correct position
events entered in recording and review with Brain Quick.

The software shall recognize and plot on the trace all events
contained in the EVT files.

MP-FR4

The software shall allow to see in the correct position the
notes included in the recording and review steps.

MP-FR5

The software shall show in the correct position the red, blue
and green flags placed during recording and review.

MP-FR6

The software shall show in the correct position the digital
triggers placed during recording and review.

MP-FR7

The software shall be able to convert recorded EEG files up
to 256 channels.

MP-FRS

The software shall be able to convert EEG files recorded up
to 16KHz.

Figure 12: Functional Requirements Document: Functional Requirements
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3.4 Stage 3: Development,verification
and validation

This is the operational phase in which all the information extracted is considered
design output.

In agreement with the R&D department managers, it was decided to develop
the plugin in the C+4 programming environment. Subsequently, an entire
chapter will be spent on precisely describing this crucial stage for the finalization
of the project.

As in all new product development processes, there was a testing phase
conducted in Micromed laboratories. How this phase was conducted and its
results will be discussed in chapter 5.

3.5 Stage 4: Market Release and
Post-marketing surveillance

Market Realese refers to the stage at which the product is formally released
for commercial distribution. Following this is the post-marketing surveillance
phase, which begins as soon as the product is released for market and contin-
ues throughout the life of the product. Inputs for post-marketing surveillance
include information and data from physicians, clinics, and hospitals.

During this thesis project this stage was not reached because the export
functionality will be formally added in a later version of the BrainQuick software
to be released in the coming months.
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Chapter 4

Matlab Plugin Development

In this chapter I will describe in detail the predominant part of the entire project,
the development phase in two different programming environments: C++ and
Matlab.

4.1 C++ Coding Environment

During the development phase, I used Visual Studio’s Integrated Development
Environment (IDE), which offers a feature set that allows you to manage large
and small code projects, write and refactor code, detect and correct errors
through static analysis, and powerful debugging tools. This set of items is
designed to guide every step needed to manage projects, write, test and debug
code, and then deploy it to another computer [4].

C++ quickly showed to be the appropriate environment for the development
of the plugin first because the company’s software infrastructure was primarily
created in this programming environment and then because, through it, I could
best manage the so-called "header” of the proprietary Micromed TRC file.

In fact, any Micromed EEG file contains a data file structure that can be
easily interpreted. Data file is broken down into two main sections: the header,
which contains the patient and setup data and a variable length trailer that
contains the digitised trace data. The sequence of this data can be interpreted
with the header block. Files have the capability to store up to 256 individ-
ual channels of signal data, the number stored in each file may vary and this
information may be found in the header [5].

In addition to this, in the new Micromed Brain Quick EEG Application
platform there is the possibility of importing events generated by external plugin
or programs. These are additional event types that are grouped in files other
than the TRC. Again, a precise data structure [6] must be followed in order to
obtain a correct definition of the event. During development, it was decided
that data export would also concern this type of event.
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So, after defining the main libraries that are useful in the C++ program, I
initialized the strings that automatically call, via path, the TRC and EVT file
whose data we want to export:

1 #include
2 #include
3 #include
4 #include
5 #include
6 #include
7 #include
8 #include
9 #include
10 #include
11 #include
12 #include
13 #include

<iostream>
<fstream>
<vector>
<iomanip>
<string>
<tinymatwriter.h>
<cmath>
<stdexcept>
<rapidxml/rapidxml.hpp>
<sstream>
<chrono>

<map>

<algorithm>

14
15
16

#include <settings.h>
using namespace rapidxml;
17 using namespace std;
18

19 ”M” .,
20

21

string TRCPATH =
string EVI PATH =
string OUTPUTPATH = 77 ;

” o,

Subsequently, I defined useful structures for export purposes; below are the
most relevant ones:

1 struct MarkerPair {

2 int begin;

3 int end;

4}

5

6 struct Event {

7 char description [64];

8 MarkerPair selection [MAXEVENT];
9 };

10

11 struct Annotation {

12 unsigned int Sample;
13 char Comment [40];
14}
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1
2
3
4
5
6
7
8
9

10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34
35
36
37
38
39
40

struct Trigger {
unsigned int Trig_Sample;

unsigned

short

struct Electrode

{

int Trig_Value; };

unsigned char Status;
unsigned char Type;

char Positive_input_-label [6];
char Negative_input_label [6];
int Logic_Minimum ;

int Logic.Maximum ;

int Logic_Ground;

int Physic_-Minimum ;

int Physic_Maximum

unsigned short Measurement_Unit;

unsigned short Prefiltering_ HiPass_Limit;
unsigned short Prefiltering_HiPass_Type;
unsigned short Prefiltering_LowPass_Limit;
unsigned short Prefiltering_LowPass_Type;
unsigned short Rate_Coefficient;

unsigned short Position;

float Latitudine;

float Longitudine;
unsigned char PresetInMap;
unsigned char IsInAvg;
char Description [32];

float X;
float Y;
float Z;
unsigned
unsigned

}s

struct Evt {

short

Cordinate_Type;

char Free[24];

string Name;
string BeginDateTime;
string EndDateTime;

string Text;

string Guid;

}s

28




struct EvtType {
string Name;

string Guid;

string Description;

struct DateTime {
unsigned char Day;

1
2
3
4
5}
6
7
8
9 unsigned char Month;

10 unsigned char Year;

11 unsigned char Hour;

12 unsigned char Minute;
13 unsigned char Second;
1}

I defined a particular class to visualize the data using the EEGlab tool, which
we will see in section 4.2:

class EegLabEvent {
public:
string type;
double latency;
int urevent;

}s

LR I N N

Then I created a structure for the “DataTime” in order to export the time
when the trace is created and events are affixed. This information will be used
in testing, as we will see in chapter 5.

struct DateTime {
unsigned char Day;
unsigned char Month;
unsigned char Year;
unsigned char Hour;
unsigned char Minute;
unsigned char Second;

Lo e N

—
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1 time_t timeParse( string& str, tm* datetime)
> {

3

4 D, h, m, s, Y, M, cns;

5 sscanf_s (str.c_str (), "%dY%d—%dT%d:%d:%d.%dZ” ,
6 &Y, &M, &D, &h, &m, &s, &cns, str.size() + 1);
7 datetime—>tm_sec = s;

8 datetime—>tm_min = m;

9 datetime—>tm_hour = h;

10 datetime—>tm_mday = D;

11 datetime—>tm_mon =M — 1;

12 datetime—>tm_year =Y — 1900;

13 mktime (datetime) ;

14}

As already anticipated, additional events are contained in an EVT file that
is an XML (Extensible Markup Language) format file; XML documents contain
data enclosed within tags that define the structure and meaning of the data
[7]. Therefore, in the C++ code it was necessary to read this file to extract
additional types of events:

1 ParseEvtFile ()

2 {

3 xml_document<> doc;

4 xml_-node<>* root_node;

5

6 // Read the xml file into a vector

7 ifstream evtFile (EVI_PATH, std::ios::out | std::ios::binary)

8

9 (evtFile) {

10 vector< > buffer ((istreambuf_iterator< >(evtFile)),
istreambuf_iterator < >());

11 buffer.push_back(’\0);

12

13 // Parse the buffer using the xml file parsing library
into doc

14 doc. parse <0>(&buffer [0]) ;

15

16 // Find our root node

17 root_-node = doc.first_node ();
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10
11
12
13
14
15
16
17
18
19
20

22

//std ::

cout << Name of my first
<< root_node—>name() <<
navigateNode (root_node);

(list <Evt>::iterator itr
itr != evtList.end(); 4++itr)

node is:

\'n

= evtList.begin();

(list <EvtType>::iterator itr2 =

evtTypeList.begin(); itr2

)
{

= evtTypeList.end(); ++itr2

((*itr).Guid = (*itr2).Guid)

(xitr).Name = (*xitr2).Name;

{

std ::invalid_argument (string

(?Cannot open input EVT file

777) +EVTPATH+77777),
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The main has a referenced to a JSON (JavaScript Object Notation) file that
will be used in the testing phase to define the file paths to be exported. Also,
after defining several quantities, the TRC file to be exported is opened and read.

1 int main(int argec, charx argv) {

2 try {

3 // read a JSON file

4 std ::ifstream i(”settings.json”);

5 json j;

6 i>>j;

7 auto settings = j.get<ExportSettings >();

8 TRCPATH = settings.trcPath;

9 EVT PATH = settings.evtPath;

10 OUTPUT PATH = settings.outputPath;

11

12 unsigned int data_start_offset;

13 unsigned int data_off_offset;

14 unsigned short int multiplexer;

15 unsigned short int numch;

16 unsigned short int Fc;

17 unsigned int campioni;

18 unsigned int length;

19 unsigned short int n;

20 const int MAXCAN = 256;

21 const int MAXTLAB = 640;

22 uint32_t eventA_pos;

23 uint32_t eventB_pos;

24 unsigned int Electrode_pos;

25 unsigned int Code_pos;

26 const int MAXFLAG = 100;

27 unsigned int Flags_pos;

28 const int MAXNOTE = 1000;

29 unsigned int Note_pos;

30 const int MAXTRIGGER = 8192;

31 unsigned int Trigger_pos;

32 unsigned char Date_pos;

33

34 // opening and reading the file

35 std ::ifstream is(TRCPATH, std::ios::out | std::ios::
binary) ;
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The crucial action for the export to be accurate was to use pointers pointing
to the different areas of the TRC file header containing useful information, such

as:

1 if (is)

) {

3 // Data length

4 is.seekg (0, is.end);

5 int length = is.tellg();

6 is.seekg(pointer_A , is.beg);

7

8 is.read ((charx)&data_start_offset , sizeof(
data_start_offset));

9 std ::cout <<  data size: << data_start_offset
<< std ::endl;

10

11 // pointer to multiplexer

12 is.seekg(pointer to multiplexer, std::ios::beg);

13 is.read ((charx)&multiplexer , sizeof(multiplexer));

14 std :: cout << data size mp: << multiplexer <<
std :: endl;

15

16 // number of channels

17 is.seekg(pointer to number of channels, std::ios::beg)
)

18 is.read ((charx)&numch, sizeof(numch));

19 std ::cout <<  numero canali: << numch << std::
endl;

20

21 // sampling rate

22 is.seekg(pointer to sampling rate , std::ios::beg);

23 is.read ((charx)&Fc, sizeof(Fc));

24 std :: cout << Frequenza di campionamento: << Fc
<< std ::endl;

25

26 // pointer on data_start

27 is.seekg(data_start_offset , std::ios::beg);

28

29 // calculate the number of samples

30 /xstd :: cout << campioni : << (length
data_start_offset) / multiplexer << std::endl;x/

31 campioni = ((length — data_start_offset) / multiplexer
)

32 std :: cout << campioni << campioni << std::
endl;

33

34 //1 identify Event A (hyperventilation )

35 is.seekg(pointer to event A, std::ios::beg);

36 is.read ((charx)&eventA_pos, sizeof(eventA_pos));

37 std :: cout << start_offset_EventoA : <<
eventA _pos << std::endl;

38

39 // I identify EventB (selection of a part of the EEG
trace made by the doctor)

40 is.seekgpointer to event B, std::ios::beg);

a1 is.read ((charx)&eventB_pos, sizeof(eventB_pos));

42 std ::cout << start_offset_EventoB : <<
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43
44
45
46
47

48
49
50
51

53
54
55
56
57

58
59
60
61
62

63

64
65
66
67
68
69
70
71
T2
73
T4
75
76
T
78

79
80
81
82
83
84
85
86
87

88
89
90
91

eventB_pos << std::endl;

// Code area

is.seekg(pointer to Code area std::ios::beg);

is.read ((charx)&Code_pos, sizeof(Code_pos));

std :: cout << Start_offset_Code : << Code_pos <<
std ::endl;

// Electrode

is.seekg(pointer to Electrode , std::ios::beg);

is.read ((charx)&Electrode_pos, sizeof(Electrode_pos));

std :: cout << Start_offset_electrode : <<
Electrode_pos << std::endl;

// Order

short int* Order = new short int[MAXCAN];

is.seekg (Code_pos, std::ios::beg);

is.read ((char*)&Order, sizeof (MAXCAN * sizeof(short
int)));

Electrodex electrodes = new Electrode [MAXLAB];
for (int e = 0; e < MAXILAB; e++)

is.seekg(Electrode_pos + e % sizeof(Electrode), std
::ios ::beg);
is.read ((charx)&(electrodes[e]), sizeof(Electrode))

)

}

Event eventA;
is.seekg(eventA_pos, std::ios::beg);
is.read ((charx)&eventA, sizeof(Event));

Event eventB;
is.seekg(eventB_pos, std::ios::beg);
is.read ((charx)&eventB, sizeof(Event));

// Flags

is.seekg(pointer to Flags, std::ios::beg);

is.read ((charx)&Flags_pos, sizeof(Flags_pos));

std :: cout << Start_offset_Flags : << Flags_pos
<< std ::endl;

MarkerPair flags [MAXFLAG];
is.seekg(Flags_pos, std::ios::beg);
is.read ((charx)&flags , sizeof(flags));

// Note

is.seekg(pointer to notes, std::ios::beg);

is.read ((charx)&Note_pos, sizeof(Note_pos));

std :: cout << Start_offset_Note : << Note_pos <<
std :: endl;

Annotation notes [MAXNOTE];

/+*Annotationx Note = new Annotation [MAXNOTE]; %/
is.seekg(Note_pos, std::ios::beg);
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92
93
94
95
96
97

115

is.read (( *)&notes , (Annotation) * MAXNOTE) ;

// Trigger

is.seekg(pointer to trigger, std::ios::beg);

is.read (( *)&Trigger_pos , (Trigger_pos));

std :: cout << Start_offset_Trigger : <<
Trigger_pos << std::endl;

Trigger triggers [MAX TRIGGER];
is.seekg(Trigger_pos, std::ios::beg);

is.read (( *)&triggers , (Trigger) =
MAX TRIGGER) ;
// Date

DateTime date;
is.seekg(pointer to DateTime date , std::ios::beg);
is.read (( *)&date , (DateTime) ) ;

// descriptor of code
is.seekg(pointer to descriptor of code, std::ios::beg)

is.read (( *)&Code_pos (Code_pos) ) ;
std :: cout << Start_offset_CodePos : << Code_pos
<< std ::endl;

Codes [MAX_.CAN];
is.seekg(Code_pos, std::ios::beg);
is.read (( *)&Codes , ( ) * MAXCAN) ;

std :: vector<std ::string> electrodes_channels;
( i =0; i < numch; i++)
{

chl = (Codes[i] & 0xff00) >> 2;
ch2 = Codes[i] & 0x00ff;
std::string s;

(ch2 > 0) {
s += electrodes [ch2]. Positive_input_label;
s 4= — ;

s += electrodes[ch2]. Negative_input_label;

(chl > 0 && ch2 > 0)

s += / ;

(chl > 0)

s += electrodes[chl]. Positive_input_label;
s += — 3

s += electrodes[chl]. Negative_input_label;}
electrodes_channels.push_back(s);}

35




With the aim of extrapolating the number of events contained in the TRC
and EVT files, I implemented a series of for cycles useful for the purpose:

N

N

© w N o o«

10
11
12
13
14
15
16
17
18
19
20
21

22
23
24
25

26

27
28
29
30

32
33
34
35

nEvents = 0;

/+ for loop in eventA and eventB to understand the
effective number of eventsx/
( i = 0; i < MAXEVENT; i++4) {
(eventA .selection[i].begin > 0
&& eventA.selection [i].begin < INT32.MAX
&& eventA.selection[i].end > 0
&& eventA.selection [i].end < INT32.MAX) {
nEvents++;

(eventB.selection[i].begin > 0
&& eventB.selection[i].begin < INT32.MAX
&& eventB.selection[i].end > 0
&& eventB.selection[i].end < INT32.MAX) {

nEvents++;
}
//1 add the count of events in the evt file
nEvents += evtList.size();
// conto anche trigger , flag e note
( i = 0; i < MAXTRIGGER; i++) {

(triggers[i]. Trig-Sample > 0 && triggers[i].
Trig_-Sample < UINT32.MAX)

nEvents++;
}
( i =0; i <MAXFLAG; i++) {
(flags [i].begin > 0 && flags[i].begin <
UINT32_MAX
&& flags|[i].end > 0 && flags[i].end < UINT32.MAX
)
nEvents++;
}
( i = 0; i < MAXNOTE; i++) {
(notes[i].Sample > 0 && notes[i].Sample <
UINT32_MAX)
nEvents+4;
}
MarkerPairx allEvents = MarkerPair [nEvents |;

std:: vector<std ::string> allEventNames;
EegLabEvent tempE;
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10

11

12
13
14

15

16
17
18
19
20
21
22
23
24
25

26

27

28

29

30

31

32

33
34

(

i = 0; i < MAXEVENT; i++) {
(eventA .selection[i].begin > 0
&& eventA .selection [i]. begin < INT32.MAX
&& eventA .selection[i].end > 0
&& eventA .selection [i].end < INT32.MAX) {
allEvents [c++] = eventA.selection [i];
string eventAName(eventA.description);
allEventNames . push_back (eventAName.length () > 0

? eventAName : EventA )

tempE.type = string ("EventA”) + (i = 0 ? 77: 7
(” 4+ to_string(i) + ”)”) + 7’— begin”;

tempE.latency = 1.0 * eventA.selection[i]. begin
/x/ Fex/;

tempE . urevent = 0;

eegLabEvents . push_back (tempE) ;

tempE.type = string ("EventA”) + (i = 0 ? 77
7(” 4+ to-string (i) + 7)”) + ”— end”;

tempE . latency = 1.0 % eventA.selection[i].end /x
/ Fc x/;

tempE. urevent = 0;

eegLabEvents. push_back (tempE) ;

(eventB.selection [i].begin > 0

&& eventB.selection[i].begin < INT32.MAX

&& eventB.selection[i].end > 0

&& eventB.selection[i].end < INT32.MAX) {
allEvents [c++] = eventB.selection [i];

string eventBName(eventB. description);
allEventNames . push_back (eventBName.length () > 0

? eventBName : EventB );

tempE.type = string ("EventB 7)) + (i = 0 ? 7”7
77(7’ + tO,StI‘ing(i) + 77)77) + »__ begin”;

tempE. latency = 1.0 % eventB.selection[i].begin
/x/ Fecx/;

tempE . urevent = 0;

eegLabEvents . push_back (tempE) ;

tempE. type = string ("EventB ”) + (i = 0 ? ””
7(” + to_string (i) + 7)”) + 7— end”;

tempE. latency = 1.0 % eventB.selection[i].end /x
/ Fex/;

tempE. urevent = 0;

eegLabEvents . push_back (tempE) ;
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At this point, T used the C++4 TinyMAT library [8] to handle writing a
Matlab file in version “MATLAB 5.0” or later. This library implements a very
simple interface to write Matlab files following the structure described in the
official MathWorks documentation. [9].

First, I used the TinyMATWriter_open() function to create a new MAT file:

TinyMATWriterFile* mat = TinyMATWriter_open(OUTPUT_PATH.c_str());

To write inside the MAT file thus created, I took advantage of several Tiny-
MAT functions which we see below generally:

e To write a string into the mat file :

TinyMATWriter_writeString (TinyMATWriterFile* mat,
const char * name,
const char * data)

e To write a single (numeric) value (as 1x1 matrix) into a MAT-file:

TinyMATWriter_writeValue (TinyMATWriterFile* mat,
const char * name,
T data_real )

e To write a 2-dimensional double matrix in column-major order into a MAT
file:

TTinyMATWriter_writeMatrix2D_colmajor (TinyMATWriterFile *mat,
const char * name,
const T * data_real,
int32_t cols,
int32_t rows )

e To write a 2-dimensional double matrix in row-major order into a MAT-
file:

TTinyMATWriter_writeMatrix2D_rowmajor (TinyMATWriterFile *mat,
const char * name,
const T * data_real,
int32_t cols,
int32_t rows )

e To write an empty (double) matrix into a MAT-file:
TinyMATWriter_writeEmptyMatrix (TinyMATWriterFile * mat,

const char * name

)
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In particular, I used these functions to export data with a precise structure
that could be replicated both in a normal Matlab environment but also through

e Start to write a struct-element:

TinyMATWriter_startStruct (TinyMATWriterFile * mat,
const char * name

)

Low-Level-Interface for writing Cell-Arrays: starts a generic Cell-Array:

TinyMATWriter_startCellArray(TinyMATWriterFile * mat,
const char * name,
const int32_t * sizes,
uint32_t ndims

)

After this function invocation, simply use any TinyM AT Writer-function to

write the cell-array entires in column-major order with “name” left blanc

Finally close the array by invoking TinyMATWriter_endCellArray(). You

can nest severall startCellArray/endCell Aray-invocations.

the EEGlab interface:

k.
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e e e
S U S

15

16

18

19

(mat) {

TinyMATWriter_startStruct (mat, "EEG”);

std::string mystr;

TinyMATWriter_writeString (mat, ”setname”, mystr);
TinyMATWriter_writeString (mat, ”filename” , mystr);
TinyMATWriter_writeString (mat, ”filepath”, mystr);
TinyMATWriter_writeString (mat, ”"subject”, mystr);
TinyMATWriter_writeString (mat, ”group”, mystr);

TinyMATWriter_writeString (mat, ”condition”, mystr);

TinyMATWriter_writeEmptyMatrix (mat, ”session”);
TinyMATWriter_writeString (mat, ”comments” , mystr);
TinyMATWriter_writeValue (mat, ”nbchan”, numch);
TinyMATWriter_writeValue (mat, ”trials”, 1);

// time points

TinyMATWriter_writeValue< >(mat, ”pnts”, 1.0
campioni)

TinyMATWriter_writeValue< >(mat, ”srate”, 1.0
x Fc);

)

*
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* timesMillis = [campioni |;
( t = 0; t < campioni; t++) {
timesMillis [t] = 1000.0 = t / Fc;

minSec = timesMillis [0] / 1000;
maxSec = timesMillis [campioni — 1] / 1000;

© W N s W N =
—

TinyMATWriter_writeValue (mat, ”xmin”, minSec);

10 TinyMATWriter_writeValue (mat, ”xmax”, maxSec);

11

12 TinyMATWriter_writeMatrix2D _colmajor (mat, ”times”
timesMillis , campioni, 1);

13 [] timesMillis;

I still use a TinyMAT function to export a matrix number of channels per
number of samples, through which the trace can be represented in EEGlab (we
will see in section 4.2) :

1 TinyMATWriter_writeMatrix2D_rowmajor (mat, ”data”, values, ( )
campioni, ( )numch) ;
Finally, I built a cell array that contained all the extracted events:
1 TinyMATWriter_startCellMatrix2D (mat, ”"Events”, 3, eegLabEvents.
size () ;

2

3 std ::map<std ::string , > m;

4 std :: map<std ::string, > kMap;

5 // campo eventi

6 ( i = 0; i < eegLabEvents.size(); i++) {

7 TinyMATWriter_writeString (mat, ””, eegLabEvents]|
i].type);

s }

9 ( i = 0; 1 < eegLabEvents.size(); i++) {

10 TinyMATWriter_writeValue< >(mat, 77,
eegLabEvents[i]. latency);

11 }

12 k = 1;

13 ( i = 0; 1 < eegLabEvents.size(); i++) {

14 eegLabEvents[i]. urevent = k++;

15 TinyMATWriter_writeValue< >(mat, 77,
eegLabEvents[i]. urevent);

16 }

17 TinyMATWriter_endCellArray (mat) ;
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1 TinyMATWriter_startCellMatrix2D (mat, ”Electrodes”
9, electrodes_channels.size());
2
3 ( i = 0; i < electrodes_channels.size(); i
++) {
4 TinyMATWriter_writeValue< >(mat, 77, 0);
5
}
6 ( i = 0; 1 < electrodes_channels.size(); i
++) {
7 TinyMATWriter_writeValue< >(mat, 7”7, 0);
8
}
9 ( i = 0; 1 < electrodes_channels.size(); i
++) {
10 TinyMATWriter_writeString (mat, 77,
electrodes_channels [i]);
11 }
12 ( i = 0; i < electrodes_channels.size(); i
++) {
13 TinyMATWriter_writeValue< >(mat, 77,
electrodes[i].Longitudine);
14 }
15 ( i = 0; 1 < electrodes_channels.size(); i
++) {
16 TinyMATWriter_writeValue< >(mat, 77,
electrodes [i]. Latitudine);
17 }
18 ( i =0; i < electrodes_channels.size(); i
++) {
19 TinyMATWriter_writeValue< >(mat, 77, 1);
20 }
21 ( i = 0; i < electrodes_channels.size(); i
++) {
22 TinyMATWriter_writeValue< >(mat, 77,
electrodes [i].X);
23 }
24 ( i = 0; 1 < electrodes_channels.size(); i
++) {
25 TinyMATWriter_writeValue< >(mat, 77,
electrodes [i].Y);
26 }
27 ( i = 0; 1 < electrodes_channels.size(); i
++) {
28 TinyMATWriter_writeValue< >(mat, 77,
electrodes[i].2);
29
30 TinyMATWriter_endCellArray (mat) ;

Running this code, it produces an output file in MAT format contains all
the data useful for identifying an EEG tracing acquired with Micromed devices.
In the next sections we will see how these data were manipulated in Matlab and
I will explain how to view them with EEGlab.
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4.2 Matlab code and use of EEGlab tool

In the first stage, where the export functionality has not yet been added directly
to the whole software, it is necessary to import the output file obtained from
the execution of the C++ program into the current folder of Matlab.

So, I structured two different scripts in Matlab; the first script handles output
files with the MAT extension. With a few lines of code, I wanted to schematize
the data as much as possible so that it would be readable for the end user.
Below is the code:

%% Load file
load(’output_file.mat’)

%% Data preparation
eventi_struct=cell2struct(Events,{’type’,’latency’,’urevent’},2);
EEG.event=eventi_struct;

Electrodes_struct=cell2struct (Electrodes,{’theta’,’radius’,’labels’,
’sph_theta’,’sph_phi’,’sph_radius’,’X’,’Y’,’Z°},2);
EEG.chanlocs=Electrodes_struct;

%% Save modified file
save output_file.mat

The most important information we can obtain from the running of this
script is:

o The structure of the events (fig. 13): type, latency (location), count (ure-
vent)

e The structure of electrodes (fig. 14): labels and different types of coordi-
nates (spherical, Cartesian)
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r—

[ ewventi_struct |

191 struct with 3 fields

Fields [e[H] type HE' latency Eﬂ urevent
1 ‘HfaRipple - begin' 16384 1
2 '‘EventB - begin’ 2231 2
3 ‘prova’ 32439 3
Ll ‘EventB - end’ 74015 4
5 ‘HfeRipple - end’ 21920 5
1 Trigger(0)' 105759 B
I '‘PhoticFlag - begin' 450560 i
3 '‘PhoticFlag - end' 557056 8
9 ‘Eventd - begin' 1021698 9
10 ‘Movement - begin' 1245184 10
1 ‘Movement - end’ 12451284 1
12 ‘HfzGamma - begin’ 1261568 12
13 ‘Annotation - begin’ 1269760 13
14 ‘Annotation - end’ 1269760 14
15 ‘EyesClosed - begin' 1294336 15
16 ‘EyesClosed - end’ 1294336 16
17 '‘HfoGamma - end’ 1368064 17
18 Trigger(1}’ 1384595 18
19 ‘Eventd - end' 1399063 19

Figure 13: Example of event structure exported from TRC file to Matlab. Three
column subdivision: type (event label), latency (sample on which the event is
placed), urevent (index)
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| Electrodes_struct = |
2561 struct with 9 fields
BH theta Hﬂ radius [ labels EH sph_theta EH sph_phi EH sph_radius EH X Hﬂ Y

1 0 0'eld01 - G2' 0 0 1 0
2 0 0'eld02 - G2' 108 a0 1 0
3 0 0'el003 - G2' 72 a0 1 0
4 0 0'el00d - G2' 130.7000 61.8000 1 0
5 0 0/'el005 - G2' 49.3000 61.8000 1 0
& 0 0)'el006 - G2' 144 90 1 0
7 0 0)'el007 - G2 36 90 1 0
] 0 0)'el008 - G2 90 45 1 0
9 0 0'el009 - G2 180 45 1 0
10 0 0'el010 - G2' 0 45 1 0
1 0 0'el011 - G2' 0 0 1 0
12 0 0'eld12 - G2' 229.3000 618000 1 0
13 0 0'el013 - G2' 310.7000 618000 1 0
14 0 0'el014 - G2' 270 45 1 0
15 0 0'eld13 - G2' 252 a0 1 0
16 0 0'eld16 - G2' 288 a0 1 0
17 0 0'el017 - G2' 180 a0 1 0
18 0 0'el018 - G2' 0 a0 1 0
19 0 0'el01% - G2' 216 a0 1 0
20 0 0/'el020 - G2' 324 a0 1 0
21 0 0'eld21 - G2' a0 a0 1 0
22 0 0'el022 - G2 270 90 1 0
23 0 0'el023 - G2 0 0 1 0
24 0 0'el024 - G2 0 0 1 0

Figure 14: Example of electrodes structure exported from TRC file to Matlab.
The label column shows the names of the main electrode and the reference
electrode (G2 in this case). In the other columns are the coordinates that allow
the electrodes to be mapped.
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With the second script, Settings Files (SET) are managed. In fact, the
C++ program allows the user, via a JSON file (we will see next chapter how it
is structured), to decide whether to save as output a file with the extension MAT
or SET. The SET filename extension is primarily associated with the generic
SET file type. This extension is usually assigned to files that contain various
settings and preferences for operating systems, applications, games, hardware
devices, etc. SET files are used by many applications, and can come in a variety
of formats, both textual and binary, with the SET extension indicating the
function of the file, rather than its format. SET files are loaded at the beginning,
and all the data in them provide initialization, or default configuration values
[10]. So, we prefer to export a SET file for displaying the TRC data using the
Matlab tool EEGLAB.

EEGLAB is an interactive Matlab toolbox for processing continuous and
event-related EEG, MEG and other electrophysiological data incorporating in-
dependent component analysis (ICA), time/frequency analysis, artifact rejec-
tion, event-related statistics, and several useful modes of visualization of the
averaged and single-trial data. EEGLAB runs under Linux, Unix, Windows,
and Mac OS X. EEGLAB provides an interactive graphic user interface (GUI)
allowing users to flexibly and interactively process their high-density EEG and
other dynamic brain data using ICA and/or time/frequency analysis (TFA),
as well as standard averaging methods. EEGLAB also incorporates extensive
tutorial and help windows, plus a command history function that eases users
transition from GUI-based data exploration to building and running batch or
custom data analysis scripts. EEGLAB offers a wealth of methods for visualiz-
ing and modeling event-related brain dynamics, both at the level of individual
EEGLAB “datasets” and/or across a collection of datasets brought together in
an EEGLAB “studyset”.

For experienced Matlab users, EEGLAB offers a structured programming
environment for storing, accessing, measuring, manipulating and visualizing
event-related EEG data. For creative research programmers and methods de-
velopers, EEGLAB offers an extensible, open-source platform through which
they can share new methods with the world research community by publishing
EEGLAB ’plug-in’ functions that appear automatically in the EEGLAB menu
of users who download them [11].
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The main advantages and features of EEGlab are:
e Academic (free) software

e Running on Matlab or standalone

e Graphic user interface

e Multiformat data importing

e High-density data scrolling

e Interactive plotting functions

e Semi-automated artifact removal

e ICA & time/frequency transforms

e Event & channel location handling

e Forward/inverse head/source modeling
e Defined EEG & STUDY data structures
e Over 120 advanced plug-in/extensions

To adapt the data in Micromed’s TRC file for visualization with EEGlab, it
was necessary to follow the EEG data structures suggested by the tool’s official
website.

First, I recreated the EEG structure (fig. 15): EEGLAB variable EEG
is a MATLAB structure that contains all the information about the current
EEGLAB dataset. As seen above, I recreated this main structure in C++
through the use of the TinyMAT library.

To fill in the different parts of this main structure, I still followed the guide-
line on EEGLAB’s data stucture; in particular, I recreated the EEG.chanlocs
(fig. 16) structure that stores the information about the EEG channel locations
and channel names.

Similarly, I filled the EEG.event (fig. 17) structure that contains records
of the experimental events that occurred while the data was being recorded,
plus possible additional user-defined events. In general, fields type, latency, and
urevent are always present in the event structure:

e type contains the event type
e latency contains the event latency in data sample unit
e urevent contains the index of the event in the original urevent table.

Other fields like position are user defined and are specific to the experiment.
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The user may also define a field called duration (recognized by EEGLAB)
for defining the duration of the event (if portions of the data have been deleted,
the field duration is added automatically to store the duration of the break (i.e.

boundary event).

setname:

filename:

filepath:

'EEG Data epochs’
‘eeglab_data_epochs_ica.set’

' fdata/matlab/esglab/sample_data/"

subject: '

group: "

condition: '’

session:
comments:
nbchan:
trials:

prits:

srate:

xmin:

amax

timas:

data:

icaact:
icawinv:
icasphere:
icaweights:
icachansind:
chanlocs:
urchanlocs:
chaninfo:

ref:

event:
urevent:
eventdescription:
epoch:
epochdescription:
reject:

stats:
specdata:
specicaact:
splinefile:
icasplinefile:

dipfit:

[1

[9=769 char]

1.9922

[1=384 double]
[32x384=88 single]
37x384=88 single]
32x32 double]
32x32 double]
[32x32 double]
[1234567 89 1811 12 13 14 15 16 17 18 19 28 21 22 23 24 25 26 27 28 29 38 31 32]
[1=32 struct]
[1=32 struct]
[1x1 struct]

" common”
[1=157 struct]
[1=154 struct]
{[2=29 char]

[2263 char] [2=36 char] " "'}

[1=88 struct]
{}
[1x1 struct]
[1x1
[1
[1

[1

struct]

[1

history: '

saved:
etc:
datfile:
: [

e
[1=1 struct]

‘eeglab_data_epochs_ica.fdt’

Figure 15: Example of EEG structure. The data should have this particular
structure in order to be uploaded to EEGLAB.
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»» EEG.chanlocs

ans =

1x32 struct array with fields:

thetsz
redius
labels
sph_theta
sph_phi
sph_radius
X

¥

£

Figure 16: Example of EEG.chanlocs structure. The electrodes data should
have this particular structure in order to be uploaded to EEGLAB.

»» EEG.ewvent

ans =
1x157 struct array with fields:
type
position
latency
urewvent

epoch

Figure 17: Example of EEG.event structure. The event data should have this
particular structure in order to be uploaded to EEGLAB.
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To handle this data, I created the following script in Matlab:

%% Load file .set
load(’-mat’,’eeglab2022.0\output_PAZ1.set’)

%% Data preparation
eventi_struct=cell2struct(Events,{’type’,’latency’,’urevent’},2);
EEG.event=eventi_struct;

Electrodes_struct=ce112struct(Electrodes,{’theta’,’radius’,’labels’,’sph_theta’,
’sph_phi’,

’sph_radius’,’X’,’Y’,’Z°},2);

EEG.chanlocs=Electrodes_struct;

%% Save modified file
save output_PAZ1l.set

%% Open eeglab interface
[ALLEEG EEG CURRENTSET ALLCOM] = eeglab;

This script is similar to the previous one with the difference that it obviously
handles SET extension files and, with the last line of code, automatically starts
the EEGlab tool by opening its main interface (fig. 18).

4] EEGLAB v2022.0 - [} x

File Edit Tools Plot Study Datasets Help N

——No current dataset

Suggested steps to get started

- Create a new or load an existing dataset:
Use "File > Import data™ (new)
Or "File > Load existing datasec™ (load)

(find tutorial data in sample data folder)

If newly imported raw dataset
"Edit > Channel locations™ (look up locations)
"File > Import event info" (for continuous data)

— Filter data: "Tools > Filter data"

Reject data: "Tools > Reject data by eye"

— Run ICA: "Tools > Run ICA"™ (can take time)

Reject by ICA: "Tools > Reject data using ICA"

Epoch data: "Tools > Extract epochs™
- Plot ERP: "Plot > Channel ERP > In scalp array”

Figure 18: Main interface of EEGLAB that is displayed when the tool is started
via Matlab. The instant before the data file is loaded is shown in the figure
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To get the useful information exported from the TRC file and to populate
the EEG structure created in C++, we need to load the output file. To do this
I click on:

File — load existing dataset — output.set — ok

as shown in fig. 19.

In this way the main information (number of channels, sampling rate, num-
ber of events) appears on the main screen (fig. 20). At the same time the EEG
structure is populated with the fields we expected (fig. 21).

In EEG we will find in the Event and Chanlocs fields, structures identical
to those seen in fig. 13 and fig. 14.
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[ EEGLAB v2022.0 — m] X

File | Edit Tools Plot Study Datasets Help m

Import data
Import epoch info

Import event info

Export

Save current dataset(s)
Save current dataset as
Clear dataset(z)
Create study

Load existing study
Save current study
Save current study as
Clear study / Clear all

Preferences

History scripts
Manage EEGLAB extensions
Quit

Figure 19: Uploading the SET file, obtained through the export feature, through
the EEGlab interface

[ EEGLAB v2022.0 — m] X

File Edit Tools Plet Study Datasets Help u

Figure 20: Main exported information that can be viewed on the EEGLAB
interface: number of channels used for acquisition, number of events on the
trace, sampling rate at which the trace was acquired
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| EEG
| 11 struct with 44 fields

Field =« Value
d: setname il
r:" filename ‘output_PAZ1.set’ I
o filepath ‘CAUsers\am_mari\Desktop\eeglab2...
<[t subject
-1 group
<|r| condition
EE session [
E comments
[ 11 nbchan 256 I
1] trials 1
FH pts 1446612
[l srate 8192 |
i xmin 0
o) xmiax 1766249
L[] times Ix1445912 double
[l eta 256x1446012 single_]
- icaact []
N i
f1
; 0
| 1] icachansind [
| E| chanlocs 256x7 struct
[ urchanlocs 11
] chaninfo Ix1 struct
(-1 ref ‘commeon’
[LE] event 1901 struct |
| £ urevent IxT struct
()] eventdescription 13 cell
HH epoch ¥
1}| epochdescription 0D cell
| £l reject Ix1 struct
5] stats IxT struct
E specdata ¥
|J_ specicaact []
|:[1| splinefile
|- icesplinefile
[ dipfit ¥}
E history 1x27 char
[ saved ‘yes'
L£| etc Ix1 struct
E urchanloc [l

spectdata J‘
run 1
|| datfile

Figure 21: Example of a real data structure exported to Matlab with the main
values of interest highlighted in red: filename (header of the output file from the
Matlab plugin), nbchan (number of channels with which the trace was acquired),
srate (sampling rate), date (number of channels per number of samples), event
(number of events on the trace)
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Chapter 5
Testing Stage

Tests on the Matlab Plugin were performed in Micromed’s testing laboratory.
The main steps followed are:

e Preparing a DLL (Dynamic Link Library) for the execution of C++ code
and drafting a user guide;

e Drafting the official test activity document (test report) and defining the
conditions under which acquire the EEG traces being exported;

e Preparation of Micromed instrumentation useful for acquisition;

e Preparation of an Excel spreadsheet in which to collect the results.

5.1 DLL and User Guide

In testing phase, it was not possible to physically add the entire BQ suite, there-
fore a dynamic link library (DLL) was made to simulate the Export function. A
DLL is a library that contains code and data that can be used by more than one
program at the same time. Any program can use the functionality contained in
this DLL to implement a dialog box. This promotes code reuse and efficient use
of memory.

Then a folder (fig. 22) was created containing the useful programs for con-
ducting the tests; this folder, along with the user guide, was also handed over
for validation to an external agency as we will see later.

In addition to the executable file, which precisely executes C++ commands,
inside the folder is also contained a file with a JSON (JavaScript Object Nota-
tion) extension, which is a format suitable for data interchange between clien-
t/server applications. As can be seen in the guide, through this file the user
can enter the path of the TRC and EVT files he wants to export to matlab
and in addition he can decide where to save the autput file but also with which
extension to save it (MAT or SET) (fig. 23).

93



» PLUGIN_TEST

MNome

7] conert140.dIl
MATLAB PLUGIN GUIDE.docx
(%] msvep140.dil
[ mevep140_1.dil
%] msvep140_2.dI
3 msvep140_atomic_wait.dll
4] msvep140_codecvt_ids.dll
I [5=] Export_Matlab.exe I
& Project8.pdb
[%] Qt5Cored.dll
I_Er settings.json I
=] TinyMATShared_Debug.dil
|%] TinyMATShared_Release.dll
,J veruntirme140.dll
%] veruntime140_1.dll

Figure 22: Folder for testing the Matlab plugin containing, in particular, a
JSON file to define the paths to the different files and an .exe file to simulate
the export activity of the Matlab plugin

2 "trcPath": "C:\\Users\‘\am mari‘\\Desktop\\PAZIENTI TEST\\EEG_xxx.TRC",

3 "evtFath™: "C:\\Users\\am_mari\\DesktDp\\PAZIENTI TEST\\EXT_m.evt",

4 "outputPath™: "C:\\Users\\am mari\\Desktop\\FILE DI COUTPUT\\output.set",
5 "startSample™: O,

€ "lengthSamples™: -1

Figure 23: Contents of the JSON file: the user can insert the path to the TRC
and Evt file he wants to export; he can also decide where to save the output file
by entering the path and with which extension (.mat or .set) to save it
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As anticipated, in order to be able to perform the tests through third parties
as well, a guide for using the plugin has been created. Below are the two main
parts of this guide (fig. 24, fig. 25):

micromed’

solutions for neurophysiology

May 31", 2022

Matlab Plugin Guide

This is test version of Matlab Plugin. This one exports the TRC and EVT files to .MAT or .SET files,
as chosen by the user.

Contents

The user receives a “Test” folder containing the following documents:
settings. json

Projectd.exe

Script Matlab and test file (folder)

Matlab Plugin Guide (file word)

Steps

« Open the setfings.json file with Notepad or amother application and set the following
information:
- Enter the TRC file path (e.g., C:Wsersiiname\\Folder\EEG_123.TRC)
- Enter the EVT file path (e.g., C:\Users\iname\Folde\EEG_456. EVT)
- Enter the path te the folder where to save the oufput. In this step the user can choose
whether to save a MAT file or a SET file (e.g., C\Wsers\iname\Deskiophoutput mat)
- Save the changes

MN.B. Is important that the file path has a double backslash
= Double-click the file Project8.exe and wait unfil appears the phrase *Press Enter to close

window” on black interface:
- Inthis step, the output file is generated and saved in the folder indicated by the user

» Test v o Cercain Tert
A Hgme - Wi modéic Tipo Dimensne

. & conemianan Fsterniong dell ap. 10 kB

% maveg140.80 Estergiome dell'ap. 36K

“ [ mmvepldd_1di Fyterninme dell ap MKR

i * % mswcp140 241 Esterione dell ap. EIKE
* 2 g 40, stemic w1 Externicrss deil sp. 55KB

. - % mevc140_codecia_ids.all Esterdiome dell'ap. mKe
Disk b # [0 Projectime d— Agpplicasione 800 KB
£ Projectipdh Program Delug I LA KR

pa [ osCond. Estarnion dell'ap._ 11639 KB
Sharepeint - Dt AT settings jrom 4— o0 File 168
[ TirghdaTShared Debug.dl Esternicres dell"ap... IT4KB

2 TinghAtTShared Rebease.dl Estersione dell'ap. L1

dicromed S.pa [ veruntime 140 41 Extmiceree ell'ap KB
18 voruntinne 140_1.d0 Estersione deil sp. R

Figure 24: Matlab plugin guide: part 1
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micromed’

golutions for neurophysiclogy

= (Open Matlab and create folder that contains the following information:
- Script Matlab {data preparation)
- Eeglab plugin (If you want to use the interface)
- Qutput file

= At this point there are two options:

1. If you exported a _set file, then you will have to open it only through the eeglab interface;
in this case:

- Run the script Matlab (Scripi_for_set_file.m) for preparing the data and open the
interface
- On eeglab interface click: File - Load existing dataset - Open “output set” file

- You are ready for any processing through interface: plot 2 Channel data(scroll) or
Edit = Channel location

2. If you exported a .mat file, then you will have to open it only through the Workspace in
Matlab; in this case:

- Run the script Matlab for preparing the data structure (easily readable)
- Double-click the output mat and visualize the data on workspace

MN.B. In both cases, the EEG structure contains all data information after running the script Matlab

Figure 25: Matlab plugin guide: part 2
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5.2 Test report with definition of acquisition con-
ditions

In order to perform tests in the business environment, appropriate documenta-
tion must be drawn up. For this reason, a report was created before the testing
phase. First, “test environment” was defined, that consist in:

e Operating System: Windows 10 Pro
e Software:

— Matlab_plugin.exe
— MATLAB / EEGLAB
— BRAIN QUICK

A detailed test plan was then written:
1. Export function functionality (fig. 26)
2. Accuracy of export function for Events (fig. 27)

3. Accuracy of conversion of EEG files recorder with different parameters
(fig. 28)

4. Correct display of exported data in EEGLAB (fig. 29)

Step | Description Expected Result Result
1 - Open settings. json - User shall be able to open the file correctly
2 - Follow the instruction and Set file path - User shall be able to insert the file path in the
- Choose whether to save a .MAT file or a .SET file correct fields and shall decide where save the
(It is recommended to save the file in the current output file
folder of Matlab) - Click on Save and then on Exit

Click on Save and then on Exit

3 - Execute the project8.exe - The Project8.exe program shall run correctly and
has no errors
4 - Creation of new output file - The output file shall be generated and saved in
folder indicated by the user
5 - Open Matlab and verify that output file saved in | - User shall open Matlab ad visualize in current
the current folder of Matlab folder previously created output file
[§] - Prepare the exported data in Matlab by running | - User shall run one of the provided scripts in
the appropriate script Matlab and shall view data in workspace or in
eeglab

Figure 26: Export function functionality Test Case
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Step | Description Expected Result Result

1 - The user shall be sure to do the test case " Export

function functionality Test Case " first.
2 - Verify the correct export of electrode | - The software shall identify the stored electrodes,
information their order and number. It shall be possible to
view the electrodes registered and associated
with the correct channel

3 - Verify the correct export of events information - The software shall show in the correct position
events entered in recording and review with
Brain Quick. The software shall show also all
events contained in the EVT files.

4 - Verify the correct export of notes information - The software shall show in the correct position
the notes included in the recording and review
steps.

5 - Verify the correct export of flags information - The software shall show in the correct position
the red, blue and green flags placed during
recording and review.

6 - Verify the correct export of digital trigger [ - The software shall show in the correct position

information the digital triggers placed during recording and
review.
Figure 27: Accuracy of export function for Events Test Case
Step | Description Expected Result Result

1 - Verify the correct export of EEG file recording up | - The software shall convert recorded EEG files up

to 32 channels to 32 channels.

2 - Repeat the previous step with all possible | - The software shall convert recorded EEG files

channel numbers (32 to 256) with a number of channels from 32 to 256.

3 - Verify the correct export of EEG file recording up | - The software shall convert EEG files recorded up

to 256 Hz to 256 Hz.

4 - Repeat the previous step with all possible rate | - The software shall convert recorded EEG files up

sampling (64Hz, 128Hz, 256Hz, 16KHz) to 16KHz.

5 - Verify the correct export of EEG trace with | - The software shall convert recorded EEG trace

several overlapping signals (sine wave, square with overlapping signals.
wave); parameters: 1 Hz — sampling rate, 1 mv —
amplitude

Figure 28: Accuracy of conversion of EEG files recorder with different parame-
ters Test Case
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Step | Description Expected Result Result
1 - Save the output file in current folder on Matlab | -
and, in the same folder, save EEGLAB plugin
2 - Run “Script_for_set file.m” contained in current | - The software shall prepare the data for eeglab
folder interface and open that interface
3 - Load output file on eeglab interface with several

command: Load = Existing data set =2 output.set

- Userview mostimpertant information on eeglab

interface (filename, number of channels,

number of events, Sampling rate)

Figure 29: Correct display of exported data in EEGLAB Test Case
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5.3 Micromed equipment for the acquisition of
EEG traces

In order to acquire EEG traces in the test environment, the Micromed propri-
etary LTM 32/64 PLUS SD headbox (fig. 30) was used.

SD LTM 32/64 PLUS amplifier is a portable device for acquisition of elec-
troencephalographic signals. It is intended to be used in the diagnosis of neu-
rological diseases characterized by episodic alteration of EEG parameters or
evoked potentials evaluation. The device is particularly suitable for prolonged
analysis (Long-Term EEG Monitoring). The device performs the typical EEG
amplifiers and recorders function, the acquisition of bioelectrical signals. The
signals are amplified, converted in digital form, formatted by a programmable
logic device and transferred to the microcontroller. This component stores them
on a RAM memory and afterward at defined times in the internal SDHC (Secure
Digital High Capacity) memory. The acquired signals are directly shown on the
headbox display . The PC is used to manage, via the software, the storage and
the review of the data transmitted on-line or off-line from the memory support.
SD LTM 32/64 PLUS models are specifically intended to be used both as am-
plifier and as ambulatory recorder; they have the possibility of working mode
completely autonomous from the PC also for the start of the acquisition, thanks
to expanded setting features included in the menus, SD LTM 32/64 PLUS is
endowed of 8 differential channels and 24/56 common reference channels. The
differential channels can be used through electronic switches as common refer-
ence channels. The device is endowed also of 2 DC channels and 3 channels
for data coming from the external oximeter. Up to four SD LTM 64 PLUS can
be used in a synchronized mode (fig. 31), allowing the acquisition of up to 256
channels at the same time.

On the front of the recorder, the LCD display allows the view of the menu
for the device setting. Moreover, this display supplies indications on record-
ing mode, acquisition time, total memory availability, impedance measure and
allows a rough view of acquired traces, in real time or in review.

Communication with the PC was via the BQ USB PLUS (fig. 32) interface
which is connected to the PC.

The device can be used as a data source for the Micromed acquisition and
review software (SystemPlus EVOLUTION). The SW interface module with
the recorder manages both the acquisition of data in real time and the reading
of the data contained in the memory support. The acquired data will be then
saved in the standard Micromed EEG format and displayed during the direct
review via the review functions included in the EEG part of the software. So,
after properly connecting the headbox and interface to the PC following the
company guidelines (fig. 33) to simulate a real acquisition situation, software
has been prepared [12].
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Figure 30: Example of SD LTM 64 PLUS Headbox: portable device for acqui-
sition of electroencephalographic signal

Figure 31: Example of synchronization of four headboxes to obtain up to 256
active channels for EEG acquisition
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Figure 32: Example of BQ USB PLUS interface to connect headbox to PC for

EEG trace acquisition

7 BQ'USB

PLUS

—

SD LTM 32/64 PLUS
Amplifier

Figure 33: Connection diagram of the several parts: for correct acquisition of
EEG tracing with Micromed devices, it is necessary to follow the connection

scheme described in the figure
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Regarding the SystemPLUS Evolution software that underlies the acquisi-
tions with BrainQuick, first, a new resource was created in which to collect data.
Resources are workspaces that identify the environment in which the data is lo-
cated; specifically, resources define where the data is physically located and the

referenced DB [13]. In this case, a local-type resource pointing to a specific
folder on the PC was used (fig. 34).

F2 Exam Filters Rec.Date
o Ve | |erom I 18/03/2022 ~|
$|:' To
Vodty feomee x|
Dption

Type Local D ata -
{~ Read Onk T Double sided Help

Desciipion  [Test Matlab Plugin gj

Fsih [\ sersham_maitDesktop\PAZIENTI TES T |

[ Enable Linked Database
ADO -JET
Fath |

Test Matlab
Plugin

Figure 34: Creating local resource “Test Matlab plugin” containing all EEG
traces acquired with Micromed equipment
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Then new patients were created and EEG traces were acquired by setting
the different conditions defined beforehand. In this way, the local resource in
Brain Quick was populated. In addition, EEG traces of real patients recorded
during demonstration sessions by Micromed staff were also imported fig. 35.

At this point the export of the resulting traces via the Matlab Plugin began
following the instructions in the previous paragraphs.

IEX BRAIN QUICK SOFTWARE

F5s F6 F7  F8 Fo  F10 F11  F12

F2 Exam Filters Rec.Date F3
Bag l—Jm\ apy Frp A o
Th. EEG EMG EP IOM EEG EMG EP

t‘;“ Resource: Test Matlab Plugin & Patient: Paziente Test Lab, Btm _|Exam: EEG Trace

Test, Test martedi 30 agosto 2022

32 ch - 256 Hz - Sinusoidal wave 1... -¥*¢ EEG Trace V%Y EEG Trace 05/07/2022 14:13:37
Paziente Test Lab, Btm marted: 5 lugiio 2022 EEG EEG
| Tea Ok, Merlo sabato 1 febbraio 1936 32 ch - 16384 Hz - Sinusoidal wav... TI4Y EEG Trace
Tea No, Magri mercoledi 16 febbraio 1921 EEG
[Thompson, Thomas sabato 8 settembre 2001 32 ch - 1024 Hz - Sinusoidal wave ... EEG%EEG Trace
Nicolas, Bienfait domenica 2 marzo 1969
Lo, Tea No domenica 25 febbraio 1934 32 ch - 1024 Hz - Sinusoidal wave ... [} EEG Trace
Papa, Tea No venerdi 18 novembre 1932 e
Smith, David lunedi 10 aprile 1995 64 ch - 256 Hz - Sinusoidal wave Shz [YYX EEG Trace
MM, Ff martedi 14 settembre 2004 Ay
Stone, Jos mercoledi 26 dicembre 1956 64 ch - 16384 Hz - Sinusoidal wav... EECG EEG Trace
Vitali, Mario lunedi 26 agosto 1946 o
Berthier, Julien lunedi 5 agosto 1991 AR o Shz [Ivié L2
Hogan, Atiya martedi 6 gennaio 2004 e GrRrE “WY¥ EEG Trace
Schultz, Idris mercoledi 4 agosto 2004 EEG
Spezzatini, Rosanna lunedi 13 febbraio 1939 128 ch - 256 Hz “V¥¥ ££G Trace
Necker, Jade lunedi 28 giugno 1999 EEG
Crisis, Aldo mercoledi 24 aprile 1935 128 ch - 16384 Hz E\é.é EEG Trace
Bronkhorst, H domenica 21 dicembre 1941 o
Petiov, P martedi 24 dicembre 1940 128 ch - 512 Hz L EEG Trace
Vermeiren, Ingrid venerdi 17 ottobre 1958 Y
56 ch - 256 Hz EEC EEG Trace ©
gl gl Resource [Available 68
Dati Demo Not available!
E29 268,31/465,20
EEG Test Matlab Local Data Not available!
Plugin Local Data new Not available!
I Test Matlab Plugin 268,31/465,20
ITEST VIDEO Not available!
micromed
Read/Write Local Zone

Figure 35: EEG traces acquisition environment. The main screen of the acqui-
sition software is shown in the figure. In the first column on the left is the list of
patients; for each patient, the middle column shows the list of exams performed,
and for each exam, the right column shows the corresponding files
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5.4 Test Performance and Results

To report the testing activity and collect data efficiently, an Excel file was
created. As an initial step, was verified that the main values of interest were
optimally exported to Matlab. The focus was on:

e Number of channels with which the EEG tracing was acquired
e Number of events posted on the trace during acquisition or review
e Sampling rate value used to acquire the EEG trace

From an initial visual survey it is clear that export is taking place with 100%
efficiency, this is then confirmed by an analytical investigation showing in the
following graphs (fig. 36, fig. 37. fig. 38).

Then the focus was on the export of events. In BrainQuick the list of events
posted to the plot is returned with the corresponding location in the format
hh:mm:ss.SSS (fig. 39). So it was important to verify that also in Matlab the
exported events were of the same type, i.e., had the same label and were placed
at the right time instant. As the data extrapolated from the TRC were struc-
tured, latency was reported in Matlab, i.e., the sample at which the event was
placed and not the time instant.

Then, by adding lines of code in Matlab, the time instant was obtained.
Nevertheless, the first tests failed (fig. 40, fig. 41) because Matlab was inclined to
round milliseconds. To solve this problem, The Matlab code has been modified
by adding the correct format for the time instant:

n=length(eventi_struct);
lat_millis=zeros(length(eventi_struct),1);

for i=1:length(eventi_struct)
lat_millis(i)=1000.0*eventi_struct(i).latency/EEG.srate;
end

t=datetime (2022,07,06,15,07,44,000) ;
t.Format=’uuuu/MM/dd HH:mm:ss.SSS’;

for i=1:length(eventi_struct)
position(i) = t + milliseconds(lat_millis(i));

end

In this way, an export of events and positions was obtained that was perfectly
congruent with Brainquick, as can be seen from the intuitive tables obtained in
Excel (fig. 42).
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Figure 36: Comparison between the number of BrainQuick events (blue) and
the number of Matlab events exported (orange)
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Figure 37: Comparison between the number of BrainQuick channels (blue) and
the number of Matlab channels exported (orange)
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Figure 38: Comparison of BrainQuick’s sampling rate (blue) and that exported
to Matlab (orange)
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Fvents (16 objects)

Search Q :

Type Text Position

I F' EEG selection 14:13:38.445
'3 HFO ripple 14:16:26.679
fl"\.lu:rte stimulation 14:16:32.546
F Hyperventilation 14:16:49.242
’; Digital trigger 7 14:16:53.726
@ Eyes open 14:17:06.066
#® Eyes closed 14:17:06.480
@ Eyes open 14:17:07.668
#® Eyes closed 14:17:08.209
f Mote eyes apened 14:17:26.656
li HFO fast ripple 14:17:29.941
’; Digital trigger : 14:17:38.574
f Mote eyes closed 14:17:54.574
P' Video selection 141819167
a HFO spike 14:18:32.370
# Note phatic 14:19:07.562

Figure 39: Example of event list in BrainQuick: for each event is shown the
type (label), text (comment) and location (data time )
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TEST T1

BRAIN QUICK MATLAB
EVENT POSITION EVENT POSITION
HF D ripple 15:07:46.436 HF O ripple 15:07-46.000
EEG selection 15:07:46. 725 EEG zelection |15:07:4E
MNaota (proval 1%:07:47.365 Mota [prova) 150747
Dligital trigger 15:07:56.910 Digitsl trigaer | 15:07-56
Photic selection 15:08:33.036 Phaotic selection| 15:08: 33
Huperventilation 15:05:45 718 Huperventilatior| 15:03:48
Movement 15:10:16.662 Movement 15:10:16
HF O gamma 15:10:18.010 HFO gamma 15:10:18
Annaotation 15:10;19.134 Annotation 15:10:13
Eyes closed 15:10:22 696 Eves closed 022
Digital trigger 19:10,33.017 Digitaltrigger | 12010:33

Cout of POSITIONS
Tl

mToEl

POSITIONS ™

Figure 40: Test 1 failed as a result of millisecond rounding in Matlab. Compar-
ison of the data from the two software showed a mismatch in milliseconds
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TEST T2
BRAIN QUICK MATLAB | DIFF
EVENT POSITION EVENT POSITION POSITION
Video selection 14:56:09.882 Video selection 14:56:09.000
Digital trigger 14:56:15 Digital trigger 14:56:15
Photic selection 14:57:39.578 Photic selection 14:57:39
Annotation 14:57:33.728 Annotation 14:57:39
HF O ripple 14:55:03 HF Dripple 14:55:03
Analysis selection | 14:59:55.716 Analysis selection 14:59:55
Annotation 1%00:57.518 Annotation 15:00:57
EEG selection 15:01:35.183 EEG selection 15:01:35
HFO gamma 15:03:13.525 HFO gamma 15:03:13
Mote 15:0:05.480 Note 15:04:08
HF O fastripple 15:04:35.623 HF O fast ipple 15:04:35
Diigital trigger 15:0d:40. 777 Digital trigger 15:0d:40
Courtt of POSITIONS
T2

Figure 41: Test 2 failed as a result of millisecond rounding in Matlab. During
this test it became clear that the problem was the rounding of milliseconds in
Matlab
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TEST T3 _ _
BRAIN QUICK MATLAB DIFF
EVENT POSITION  |EVENT POSITION POSITION
Video selection 16:41:28.473 | Wideo selection | 16:41:28.473 VERIFIED
Pain stimulus 16:4%:23. 6580 | Pain stimulus 16:41:23.680 VERIFIED
Nate 16:42:41.273 | Note 164241273 VERIFIED
Huperventilation 16:42:21.533 |Huperventilation  |16:42:215393 VERIFIED
Hyperventilation 16:40:17.345 | Hyperventilation | 16:410:17.348 VERIFIED
HF O ripple 16:41:48.507 | HF O ripple 16:41:48.507 VERIFIED
HFO gamma 16:40;33.177 |HFO gamma 64033177 VERIFIED
Eves closed 16:41:31.980 |Eyes clozed 16:41:31.950 VERIFIED
Artefact 16:40:35.560 ] Artefact 16:40.35.560 VERIFIED
Arinotation 16:42:59.018 | Annatation 16:42:59.018 VERIFIED
Court of POSITION
T3
POSITIONS ~
10; 100%
TEST T4
BRAIN QUICK MATLAB DIFF

EVENT POSITION  |EVENT POSITION POSITION
HF O ripple 15:07.46.436 | HF O ripple 1%:07.46.436 VERIFIED
EEG selection 15:07:46.725] EEG selection 15:07:46.725 VERIFIED
Digital trigger 15:07.56.310 | Digital trigger 15:07.56.9310 VERIFIED
Photic selection 15:08: 39,036 | Photic selection | 15:08:33.036 VERIFIED
Hupervertilation 15:09:48. 718 |Hyperventilation  [15:09:458.718 VERIFIED
Mavemerit 15:10:16.862 | Movement 15:10:16.662 VERIFIED
HFO gamma 15:10:18.010 |HFO gamma 15:10:18.010 VERIFIED
Annotation 15:10:13.139 | Annatation 1%:10:13.134 VERIFIED
Euves closed 15:10:22 636 | Eves clozed 15:10:22 636 VERIFIED
Digital trigger 15:10:33.017 | Digital wrigger 15:10:33.017 VERIFIED
Note 15:07:47.965| Note 15:07:47.965 VERIFIED

Coume of POSITION

T4

Figure 42: Examples of successful tests. The milliseconds are rounded correctly
and thus the position (time) corresponds to the position in Brain Quick
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Chapter 6

Validation and Future
Developments

The validation phase was handled by Professor Stefano Seri of Birmingham
Children’s Hospital, Micromed’s partner for many years. Professor Seri is a
Doctor of Medicine and Surgery specializing in Developmental Neuropsychiatry.
His medical practice focuses on the research and treatment of epileptic events
in pediatric patients.

The possibility of manipulating data and identifying events easily through
the export to Matlab that I created allows him to efficiently view, edit and
archive his patients’ trace data as he also has the ability to export even small
parts of Long Term Monitoring.

In addition, by exporting to Matlab he was able to do quick analysis and
draw up a trend of seizure events of patients whose large numbers of tracings
had been acquired. In fact, through the plugin and to the availability of events
and their positions over time in tables, it is possible to perform simple statistics
of relevant events of a patient at different times of hospitalization.

Dr. Seri not only gave us positive feedback regarding the usability of the
Matlab Plugin but also put attention on what could be future developments.

The main suggestions concern the following points:

e Implementation of export of data obtained by intracranial stimulation;
e Ability to create groups of montages and visualize them in Matlab;

e Obtaining correct date and time format of events without using scripts in
Matlab;

e Obtaining correct date and time format of events without using scripts in
Matlab;

e Reduce export times, which to date are estimated to be about 3 min-
utes for monitoring of a few hours and about 10 minutes for Long Term
Monitoring.
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6.1 Conclusion

Micromed is among the few manufacturers in the area of electroencephalog-
raphy to collaborate with researchers around the world to help advance the
neuroscience and neurophysiology fields.

The main focus of this thesis work was to create a Plugin that would make
data formats acquired with Micromed systems fully compatible and viewable in
the Matlab environment and through the EEGLAB tool to support research.

During the internship activity in Micromed, which lasted about five months,
the planned goal was achieved. Through the implementation of code in C++
and the use of specific libraries, it was possible to export files containing EEG
traces recorded with Micromed devices with 100% efficiency.

An intensively testing phase provided evidence that the export was a useful
tool for clinicians and researchers to efficiently visualize data by creating statis-
tics and trends of epileptic events.

Validation at an accredited center such as Birmingham Hospital confirmed
that the possibility of viewing data in EEGLAB will facilitate analysis activities

on large groups of patients and exams.

The Matlab Plugin created, will enrich the new Brain Quick Software to be
released by Micromed’s research and development team in the next few months.
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